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This guide details the method for using DefendX Software Control-QFSϯ ŦǊƻƳ ŀƴ ŀŘƳƛƴƛǎǘǊŀǘƻǊΩǎ ǇŜǊǎǇŜŎǘƛǾŜΦ ¦Ǉƻƴ 
completion of the steps within this document, DefendX Software Control-QFS will be used to manage your enterprise 
community successfully. 



                                     Copyright © 2019 DefendX Software 
  2 

 

Table of Contents 
Executive Summary................................................................................................ 5 

5ŜŦŜƴŘ· {ƻŦǘǿŀǊŜ {ƳŀǊǘ tƻƭƛŎȅ aŀƴŀƎŜǊϰ hǾŜǊǾƛŜǿ ............................................ 7 

Preparing the Control-QFS Machine ...................................................................... 8 

Preparing NetApp Filers ......................................................................................... 8 

Enabling the fpolicy Management Service (NetApp Filers) ..................................... 8 

Adding Your Filer to the DefendX Software Control-QFS Policy Hierarchy ........... 10 

Preparing the EMC CIFS Server ............................................................................ 11 

Preparing the DefendX Software Control-QFS Windows Machine ....................... 11 

Preparing the EMC CIFS Server for DefendX Software Control-QFS Management 13 

Adding a CIFS Server to the DefendX Software Control-QFS Policy Hierarchy ...... 15 

Preparing Hitachi NAS .......................................................................................... 16 

Preparing the Hitachi NAS for DefendX Software Control-QFS Management ...... 16 

Adding an EVS to the DefendX Software Control-QFS Policy Hierarchy ................ 20 

NRT (Near Real Time) Devices .............................................................................. 21 

Preparing EMC Isilon ............................................................................................ 23 

Preparing the EMC Isilon for DefendX Software Control-QFS Management ........ 23 

Adding an Isilon to the DefendX Software Control-QFS Policy Hierarchy ............. 24 

Preparing Dell NAS ............................................................................................... 25 

Preparing the Dell NAS for DefendX Software Control-QFS Management ........... 25 

Adding a Dell NAS to the DefendX Software Control-QFS Policy Hierarchy .......... 26 

User Group Resolution ......................................................................................... 27 

Group Group Resolution ...................................................................................... 27 

Group Group Resolution Configuration................................................................ 27 

NAS Device Registeration Status .......................................................................... 28 

Checking the Container Status ............................................................................. 31 

Diagnosing NAS Device Status .............................................................................. 33 



                                     Copyright © 2019 DefendX Software 
  3 

Showing Advanced Configuration Parameters ..................................................... 35 

Locking Configuration Parameters ....................................................................... 37 

Relating Basic/Advanced Mode with Locking state .............................................. 39 

DefendX Software Control-QFS System Dashboard (QSD) ................................... 57 

Setting the DefendX Software Control-QFS Application Properties ...................... 59 

Sizing Options ................................................................................................... 61 

Policy Creation ..................................................................................................... 62 

Creating Disk Quota Policies ................................................................................ 63 

Creating File Control Policies ............................................................................... 65 

Creating File Management Policies ...................................................................... 66 

Viewing Directories .............................................................................................. 67 

Viewing Shares ..................................................................................................... 68 

DefendX Software DeepScan® ............................................................................. 69 

5ŜŦŜƴŘ· {ƻŦǘǿŀǊŜ ½ƛǇ{Ŏŀƴϰ ................................................................................ 71 

DefendX {ƻŦǘǿŀǊŜ 9ƴŘ ¦ǎŜǊ {ǳǇǇƻǊǘ LƴŦǊŀǎǘǊǳŎǘǳǊŜϰ ό5ŜŦŜƴŘ· {ƻŦǘǿŀǊŜ 9¦{Lϰύ 72 

DefendX Software Control-QFS Email Templates ................................................. 74 

Adding an Email Template to DefendX Software Control-QFS ............................. 75 

Specifying a File Control Message ........................................................................ 78 

DefendX Software Storage HelpSite ..................................................................... 81 

DefendX Software End User Support Infrastructure Website .............................. 81 

5ŜŦŜƴŘ· {ƻŦǘǿŀǊŜ {ǘƻǊŀƎŜ LƴǾŜǎǘƛƎŀǘƻǊϰ ............................................................ 82 

Administering DefendX Software Control-QFS Service through a DefendX Software 

Control-QFS Admin Client Running on a Different Machine ................................. 83 

Installing DefendX Software Smart Policy Manager Admin Component .............. 84 

Installing DefendX Software Control-QFS Admin Component .............................. 90 

Administering DefendX Software Control-QFS through an DefendX Software 

Control-QFS Admin Client Running on a Different Machine ................................. 94 

DefendX Software Control-QFS Admin Reports ................................................... 96 



                                     Copyright © 2019 DefendX Software 
  4 

Viewing Control-QFS Admin Change Log Report .................................................. 97 

Importing/Exporting Control-QFS Admin Change Log Data ................................ 100 

DefendX Software Control-QFS for NAS Configuration Wizard .......................... 101 

Using the CLI ...................................................................................................... 102 

Usage ................................................................................................................. 102 

Quick Reference ................................................................................................. 103 

Command Reference ......................................................................................... 104 

Appendix: ........................................................................................................... 132 

Installing DefendX Software Control-QFS in Clustered Environments ................ 133 

Installing DefendX Software Control-QFS onto a Node Server ........................... 137 

Enabling Data ONTAP fPolicy Management Service ........................................... 139 

Assign Permissions to User Account to Execute cDOT APIs ................................ 141 

DefendX Software Control-QFS and DefendX Software On-Demand Data 

aƻǾŜƳŜƴǘϰ όh55aύ  LƴǘŜƎǊŀǘƛƻƴ ..................................................................... 143 

Message Variables ............................................................................................. 144 

Updating the License Keys ................................................................................. 144 

About DefendX Software ................................................................................... 145 

DefendX Software Professional Services ............................................................ 145 

Legal & Contact Information .............................................................................. 146 

 



                                     Copyright © 2019 DefendX Software 
  5 

Executive Summary 

Thank you for your interest in the DefendX Software Control-QFS®. DefendX Software Control-
QFS controls storage for millions of users worldwide. DefendX Software Control-QFS extends our 
best-of-breed technology, allowing you to manage Windows® and NAS-hosted storage as a 
seamless whole. 

Given the architecture of your NetApp® Filer®, EMC® CIFS Server, EMC® Isilon, Dell® NAS or 
Hitachi® NAS, DefendX Software Control-QFS does its job remotely. DefendX Software Control-
QFS uses a connector service to create a bridge and include Filers/CIFS Servers/Hitachi 
NASs/Isilon/Dell NASs as full participants in storage environments controlled by DefendX 
Software Control-QFS. In light of this fact, you will need to install the NAS/EMC/Hitachi/NRT 
connector on one of the Windows Server® 2008, Windows Server® 2012, or Windows Server® 
2016 machines in your environment. This may be an existing server or workstation or a 
standalone system. 

To be managed by DefendX Software Control-QFS, version 6.5 or later (excluding versions 7.1) of 
the Data ONTAP® operating system for Filers, or version 5.6.49.3 or later of the DART operating 
system for CIFS Servers, or version 6.1.1684.18 of or version 6.1.1684.18 of the HOS operation 
system for Hitachi NASs is required.  

DefendX Software Control-QFS can be used to manage Windows servers, Filers, CIFS Servers, 
Hitachi NASs, Filer clusters, CIFS Server clusters, and Hitachi NAS clusters, EMC Isilons, Dell NASs, 
or any combination of these systems.  

DefendX Software Control-QFS imposes no restrictions on how you organize or manage your 
storage. You can impose policies on individual directories, users, and/or groups of users. Unlike 
Control-QFS for NAS, Control-QFS for Windows has the ability to set quotas on files. 

NOTES: 

¶ Version 5.6.49.3 or later of the DART operating system is the minimum for CIFS 
support.  

¶ Version 7.3 or later of the Data ONTAP operating system is required for NFS support.  

¶ If Control-QFS is installed on a Windows Server 2008 or later, it is then 
recommended to upgrade to Data ONTAP version 7.3.3 or later 

¶ Version 8.2 or later of the Data ONTAP operating system is required for supporting 
Cluster mode NetApp Filer. 

¶ With HOS operation system for Hitachi NASs - If Control-QFS is installed on a 
Windows Server 2008 or newer, then the HOS version must be 7.0.2010.00 or later. 

¶ If you want to use email-based messaging and notifications, access to an email 
server is required. 
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To install DefendX Software Control-QFS on Windows, a login with administrator rights is needed. 
You will be installing three different services: the DefendX Software {ƳŀǊǘ tƻƭƛŎȅ aŀƴŀƎŜǊϰ 
service, the Control-QFS service, and the NAS/EMC/Hitachi/NRT connector service. 

The DefendX Software Smart Policy Manager service should be installed with a domain user 
account as its service account so that it can communicate with your mail system and other 
storage servers with which it may share policies. The Control-QFS service requires a domain user 
account with local administrative rights on the Filer, EMC CIFS Server, Hitachi NAS, EMC Isilon, or 
Dell NAS. The Control-QFS connector service uses this account as well. 

Your hardware should be appropriate for the services running on each machine. 
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DefendX Software {ƳŀǊǘ tƻƭƛŎȅ aŀƴŀƎŜǊϰ hǾŜǊǾƛŜǿ 

The first step in using DefendX Software Control-QFS is to lay out your strategy for quota policies 
ŀƴŘ ŦƛƭŜ ŎƻƴǘǊƻƭ ǇƻƭƛŎƛŜǎΦ .ŜŦƻǊŜ ŘƻƛƴƎ ǘƘƛǎΣ ǘƘƻǳƎƘΣ ƭŜǘΩǎ ƭƻƻƪ ŀǘ ƻǳǊ ǳƴŘŜǊƭȅƛƴƎ ǇƻƭƛŎȅ-based rules 
engine: DefendX Software Smart Policy Manager. 

DefendX Software Smart Policy Manager allows you to organize your storage resource 
management policies in a way that is a unique fit to your organization. If you manage by 
geography or administrative unit, you can use that plan. If you manage by class of machine, that 
approach works just as well. Often, companies use a mixed mode τ perhaps geography, 
department, and type of machine. DefendX Software Smart Policy Manager has the flexibility you 
need to make using DefendX Software Control-QFS simple. 

Once you have laid out your management structure, DefendX Software Smart Policy Manager 
provides policy replication throughout your enterprise. It allows machines to access the policies 
in their containers and inherit policies from all levels above that point in your hierarchy. You no 
longer need to configure and manage the machines on your network one by one. 

As you start to configure the software you have installed, begin with the top-level container 
under the root organization (in the following example, My Site). This is the Global Network 
configuration, whose container we created during installation. 

 

NOTE: With Control-QFS for Windows, the application name in the hierarchy is DefendX 
Software Control-QFS and not Quota & File Sentinel as with Control-QFS for NAS.   
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Preparing the Control-QFS Machine 

To prepare the Control-QFS machine, you need to add HOSTS and LMHOSTS file entries that 
include the IP address and the CIFS server name of the EVS. The IP address should be the one of 
the dedicated network. It is recommended that the Control-QFS software and the Filer be 
connected via a dedicated/private network.  If it is connected to a private network, then the 
HOSTS and LMHOSTS file entries need to be modified.  If using the public network, then the 
companies DNS infrastructure should be sufficient. 

Important: The logon account used to register with the NetApp Filer (the account that will be 
assigned to the Control-QFS ŎƻƴƴŜŎǘƻǊ ǎŜǊǾƛŎŜύ ƴŜŜŘǎ ǘƻ ōŜ ŀ ƳŜƳōŜǊ ƻŦ ǘƘŜ CƛƭŜǊΩǎ ƭƻŎŀƭ 
administrator group. 

Preparing NetApp Filers  

Refer to this section only if you have NetApp Filers attached to your environment. If you do not 
have a NetApp Filer, you should not apply the instructions specified in this section. 

Enabling the fpolicy Management Service (NetApp Filers) 
DefendX Software Control-QFS requires NetApp Filers to run Data ONTAP version 6.5 or later 
(excluding versions 7.1). 

NOTES:  

¶ Versions 8.0 and 8.1.0 of ONTAP can run in one of two modes; 7-mode or C-
mode.  

¶ DefendX Software Control-QFS for NAS, NetApp Edition requires the Cluster 
mode NetApp Filer to run Data ONTAP version 8.2 or later. 

 

If the Control-QFS license key supports NFS, the managed Filer ONTAP version need to be 7.3 or 
newer. If Control-QFS is running on Windows Server 2008 or newer, it is recommended to 
upgrade to ONTAP version 7.3.3 or newer. If your Filer is running any version that is not 
supported, you must upgrade your operating system before you proceed; please refer to your 
NetApp documentation for instructions. 

DefendX Software Control-QFS supports NFS with NetApp Filers. DefendX Software Control-QFS 
ŘŜǇŜƴŘǎ ƻƴ ǘƘŜ ǇǊƻǇŜǊ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƻŦ ǘƘŜ CƛƭŜǊΩǎ ǳǎŜǊ ƳŀǇǇƛƴƎ ŦƛƭŜΦ tƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ȅƻǳǊ bŜǘ!ǇǇ 
documentation for instructions on how to set up the Filer user mapping file. 
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Data ONTAP versions 7.0.6 and 7.2.2 contain a number of fixes that address stability and memory 
issues related to fpolicy functionality in Data ONTAP. NetApp strongly recommends that 
customers using fpolicy move to one of these Data ONTAP versions or later (excluding version 
7.1). 

The Data ONTAP 7.1 release family is currently not supported by fpolicy. 

For more information on NetApp Filers, consult NetApp Customer Support Bulletin CSB-0704-02: 
Fpolicy Update for Data ONTAP. 
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Adding Your Filer to the DefendX Software Control-QFS Policy 
Hierarchy 
Next, you need to add your Filer to the collection of servers being managed by DefendX Software 
Control-QFS. 

1. Run DefendX Software Control-QFS Admin by clicking Start > Programs > DefendX Software 
Control-QFS for NAS > DefendX Software Control-QFS for NAS Admin. 

2. Right-click My Site and select New > Filer. 

3. You will be prompted to enter a name. The name you enter here must match the name of 
your NetApp Filer. 

4. Now that you have added your Filer to the collection of servers recognized by DefendX 
Software Control-QFS, right-click the Filer you just added and select New > Quota File & 
Sentinel Application. Entries will appear under the Filer for Disk Quota and File Control 
policies. 

5. Next, we need to associate the policies you will create here with a Filer. In the DefendX 
Software Smart Policy Manager hierarchy view (the left pane), click the plus sign (+) adjacent 
to the name of the Windows-based server on which you installed DefendX Software Control-
QFS. 

6. Right-click Quota & File Sentinel under that entry and select Properties to open the DefendX 
Software Control-QFS Configuration screen. 

7. Click the NetApp Connector tab. 

8. Click the Add button. 

9. Enter the name of your Filer and click OK. 

10. Click OK in the DefendX Software Control-QFS Configuration screen. 
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Preparing the EMC CIFS Server 

Refer to this section only if you have one or more EMC CIFS Servers attached to your 
environment. If you do not have EMC CIFS Servers, you should not apply the instructions specified 
in this section. 

Preparing the DefendX Software Control-QFS Windows 
Machine 
Perform the the following steps to prepare the Windows machine to host DefendX Software 
Control-QFS: 

1. Before installing DefendX Software Control-QFS, you have to make sure that Celerra Event 
Enabler (CEE) version 4.5.2.3 or later is appropriately installed and configured in your 
environment. Contact EMC for further information on this configuration. CEE versions from 
6.0.0 until 6.0.3 are not supported. If you will install CEE version 6.x then it must be 6.0.4 or 
higher. If you need to manage VNX ( 8.1.3+), then you must use CEE version 6.6 or higher. 

2. DefendX Software Control-QFS requires the EMC Celerra to run DART version 5.6.49.3 or 
later. If your Celerra is not running version 5.6.49.3 or later, you must upgrade your operating 
system before you proceed; refer to your EMC documentation for instructions. 

3. After installing the Celerra Event Enabler on the DefendX Software Control-QFS machine, you 
need to specify the software with which the CEE will register. To do this, set NTP for the 
following key: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ EMC\ Celerra Event 

Enabler \ CEPP\ CQM\ Configuration \ EndPoint  

If you installed CEE version 6.0.4 or higher, then the registry value will be: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ EMC\ CEE\ CEPP\ CQM\ Configuration \ End

Point  

NOTES:  

¶ If DefendX Software Control-QFS is installed on an environment that has 
'DefendX Software FA with Proxy Service' installed, the registry value named 
"ProxyServer" in the registry key named 
"HKEY_LOCAL_MACHINE\SOFTWARE\NTPSoftware\ECS" on the Control-
QFS machine must be set to the machine name on which 'FA with Proxy 
Service' is installed. This allows DefendX Software Control-QFS ŀƴŘ ΨC! ǿƛǘƘ 
tǊƻȄȅ {ŜǊǾƛŎŜΩ ǘƻ ǿƻǊk properly on the same environment. 
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ImportantΥ ¢ǿƻ ǎǇŜŎƛŀƭ ǇŜǊƳƛǎǎƛƻƴǎΤ ά9ǾŜƴǘ bƻǘƛŦƛŎŀǘƛƻƴ .ȅtŀǎǎέ ŀƴŘ ά±ƛǊǳǎ /ƘŜŎƪƛƴƎέΣ ǎƘƻǳƭŘ ōŜ ŀǎǎƛƎƴŜŘ ǘƻ ǘƘŜ 
EMC connector service account on the PDM that hosts the managed CIFS Server 

EMC Connector service is registering with only one EMC Proxy service. That EMC Proxy service 
registers with all EMC CAVA services that are registered with all managed EMC NAS devices.  

The connector registry key in EMC edition is: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ NTPSoftware\ ECS 

The following registry value needs to be configured under the connector registry key: 

ProxyServer: a string value, that should contain either the NetBiosName or the Fully 
Qualified Domain Name (FQDN) of the NAS Proxy service machine. If this value is empty 
or doesn't exist, the local machine name is used. 

Important:  

¶ There is flexibility to manage specific NAS device(s) through NAS Proxy service different 
than the one defined in the connector registry key.  

¶ The user can create the ProxyServer registry value under the NAS device registry key, 
to allow the Connector service to manage this specific NAS device by a specific NAS 
Proxy service. This registry value is not created under the NAS device registry key by 
default.  

¶ The user needs to create it manually, only if, he/she needs to manage this specific NAS 
device by a specific NAS Proxy service.  

¶ If this value is empty or doesn't exist, the value under the connector registry key will be 
used, if it is also empty or doesn't exist, the local machine name is used. 

The NAS device registry key in EMC edition is: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ NTPSoftware\ ECS\ ConnectedCelerras\ <Device name> 

The following are the two registry values that the user might set in the registry per the NAS 
device, in addition to the ProxyServer registry value described above.  

I. ApplicationPriority: the NAS Proxy service orders registered applications based on 
priority. This registry value is a DWORD value that should contain the application 
priority according to which it will receive the requests from the registered NAS Proxy 
services, and its responses will be processed by those NAS Proxy services. The default 
value for this registry value is 4, and the minimum is 0 and the maximum is 100. If the 
user sets this registry value to any value outside this range, Control-QFS will set it 
automatically to the default value. 

II. ConnectionMaintPeriodInSec: A DWORD value that should contain the interval in 
seconds for the Connector service to check the status of its connection with the 
registered NAS Proxy services that is managing this NAS device. The default value for 
this registry value is 4 seconds, and the minimum is 1 second and the maximum is 300 
seconds (5 minutes). If the user sets this registry value to any value outside this range, 
Control-QFS will set it automatically to the default value. 
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4. The following are the two registry values that the user might set in the registry per the NAS 
device for the NAS Proxy service. 

HKEY_LOCAL_MACHINE\ SOFTWARE\ NTPSoftware\ NasProxy\ ConnectedNasDevices\ <Dev
ice name> 

¶ ConnectionMaintPeriodInSec: A DWORD value that should contain the interval in seconds 
for the NAS proxy service to maintain the connection with the registered NAS device. The 
default value for this registry value is 4 seconds, and the minimum is 1 second and the 
maximum is 300 seconds (5 minutes). If the user sets this registry value to any value outside 
this range, the NAS Proxy service will set it automatically to the default value. 

¶ NoReqProcThreads: A DWORD value that should contain the number of requests processing 
threads for the managed NAS Device. The user can change this value according to the load 
on each of their managed NAS devices i.e. Increase the number of threads for busy NAS 
devices and decrease it for non-busy NAS devices. The default value for this registry value is 
20 threads, and the minimum is 1 thread and the maximum is 50. If the user sets this registry 
value to any value outside this range, the NAS Proxy service will set it automatically to the 
default value. 

NOTES: 

1. Changing the NoReqProcThreads registry value requires restarting the NAS 
Proxy service, so as the change takes effect. 

2. In EMC edition, there are no updates related to the EMC CAVA service registry 
key/values. Each CAVA service should indicate its proxy server (which could be 
remote or local) using the endpoint registry value.  

3. If the proxy server is local, the endpoint registry value should have the word 
'ntp', otherwise the endpoint registry value should have the word 
'ntp@ProxyServerFQDN' , i.e if the proxy service is installed on a machine named 
'DevTeam.NTP.com' and it is not the local machine on which the EMC CAVA 
service is installed, then the endpoint registry value on the EMC CAVA service 
machine should be 'ntp@DevTeam.NTP.com'. 

 

Preparing the EMC CIFS Server for DefendX Software Control-
QFS Management 
For any CIFS Server that will be managed by DefendX Software Control-QFS, once the server is 
started and has mounted its root filesystem, go to the .etc directory and create the cepp.conf file 
(if it does not exist). You have to edit this file to include your CEPP pool description. 

NOTE: The cepp.conf file must contain at least one line defining the pool of CEPP 
servers. If the line is too long, you can add \  at the end of each line: 
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pool name=<poolname> servers=<IP addr1>|<IP addr2>|... \  

preevents=<event1>|<event2>|.... \  

postevents=<event3>|<event4>|.. \  

posterrevents=<event5>|<event6>|... \  

option=ignore or denied \  

reqtimeout=<time out in ms> \  retrytimeout=<time out in ms>  

 

Kindly note: 

¶ Each event can include one or more (or all) of the following events: 

o OpenFileNoAccess 

o OpenFileRead 

o OpenFileWrite 

o CreateFile 

o CreateDir 

o DeleteFile 

o DeleteDir 

o CloseModified 

o CloseUnmodified 

o RenameFile 

o RenameDir 

o SetAclFile 

o SetAclDir 

¶ Postevents and posterevents are not supported in DefendX Software Control-QFS. We 
recommend turning them off to improve performance. Dropping those two fields from the 
CEPP will stop the Celerra Control Station from generating events of those types from that 
Data Mover. 

¶ At least one event, one pool, and one server per pool must be defined. 

Recommended timeout values: 
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¶ The recommended value for reqtimeout is 5000. 

¶ The recommended value for retrytimeout is 750. 

Perform the following steps to edit the cepp.conf file: 

1. Log on to the celerra control station as su. 

a. Type mount server_2:/ /mn t2  to mount the root filesystem. (Create /mnt2 if 
it does not exist, and replace server_2 with your Physical Data Mover name if you are 
configuring a different Physical Data Mover.) 

b. Type cd /mnt2/.etc and look for the file cepp.conf. Create the file if it does not exist. 

c. Use vi to edit the cepp.conf file. Edit the servers field to use the IP address of the 
machine running DefendX Software Control-QFS. The result should look something 
like this: 

pool name=cqm servers=10.30.3.57 preevents=* option=ignore 

reqtimeout=5000 retrytimeout=750  

2. Type server_cepp server_2 ςservice -stop and press Enter. 

3. Type server_cepp server_2 ςservice -start and press Enter. 

NOTE: Replace server_2  with the name of the Physical Data Mover you want to 
configure. 

These steps create the configuration that allows DefendX Software Control-QFS to register with 
and manage your CIFS Server. They must be completed before you try to configure DefendX 
Software Control-QFS. 

Adding a CIFS Server to the DefendX Software Control-QFS 
Policy Hierarchy 
Next, you need to add your EMC CIFS Server to the collection of servers being managed by 
DefendX Software Control-QFS. 

1. Run DefendX Software Control-QFS Admin by clicking Start > Programs > DefendX Software 
Control-QFS for NAS > DefendX Software Control-QFS for NAS Admin. 

2. Right-click My Site and choose New > Celerra. 

3. You will be prompted to enter a name. The name you enter here must match the name of 
your EMC CIFS Server. 
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4. Now that you have added your EMC CIFS Server to the collection of servers recognized by 
DefendX Software Control-QFS, right-click the EMC CIFS Server you just added and select New 
> Quota & File Sentinel Application. 

Entries will appear under the EMC CIFS Server for disk quota and file control policies. 

5. Next, you need to associate the policies you will create here with an EMC CIFS Server. In the 
DefendX Software Smart Policy Manager hierarchy view (the left pane), click the plus sign (+) 
adjacent to the name of the Windows-based server on which you installed DefendX Software 
Control-QFS. 

6. Right-click Quota & File Sentinel under that entry and select Properties to open the DefendX 
Software Control-QFS Configuration screen. 

7. Click the EMC Connector tab. 

8. Click the Add button. 

9. Enter the needed information; name of your EMC CIFS Server, the control station IP, 
username, and password. At the end of the wizard, click Finish. 

10. Click OK in the DefendX Software Control-QFS Configuration screen. 

You are ready to move on and create some policies. 

Preparing Hitachi NAS 

Refer to this section only if you have Hitachi NASs attached to your environment. If you do not 
have Hitachi NASs, you should not apply the instructions specified in this section. 

Preparing the Hitachi NAS for DefendX Software Control-QFS 
Management 
There is now one generic NAS proxy service handling both EMC and Hitachi editions. The registry 
configuration needs to be configured properly to manage the NAS devices correctly. 

To prepare the Hitachi NAS server, the following must be taken into consideration: 

1. For each EVS (virtual server) managed by DefendX Software Control-QFS, at least one CIFS 
server name must be created and must join the same domain as the Control-QFS machine. 

2. The logon account used to register with the Hitachi NAS (the account that will be assigned to 
the Control-QFS connector service) needs to be a member of the Hitachi server's local group 
Backup Operators, which can be added from the Hitachi Server command-line interface (CLI) 
using the following command: 
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localgroup add "Backup Operators " <FQDomainName \ AccountName>  

3. The File-Filtering feature must be enabled. To enable it, use the following command: 

fsm set allow - ntp - file - filtering true  

4. Turn on File-Filtering after the Connector service is started. This can be done by running the 
following command on the Hitachi Server management CLI (it will start the notifications flow): 

file - filtering ïon 

NOTE: The preceding step must be performed after DefendX Software Control-QFS 
is fully installed, so please follow up on the installation sections step by step, as 
explained in the Installation Guide, until you are advised to perform this step. 
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5. In the Hitachi connector registry key, enter the following key: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ NTPSoftware\ BCS 

 

The following registry value needs to be configured under the connector registry key: 

¶ ProxyServer: A string value that should contain either the NetBiosName or the Fully Qualified 
Domain Name (FQDN) of the NAS Proxy service machine. If it is empty or doesn't exist, the 
local machine name is used. 

NOTES:  

¶ There is flexibility to manage specific NAS device(s) through NAS Proxy service different 
than the one defined in the connector registry key.  

¶ The user can create the ProxyServer registry value under the NAS device registry key, 
to allow the Connector service manage this specific NAS device by a specific NAS Proxy 
service.  

¶ This registry value is not created under the NAS device registry key by default. The user 
needs to create it manually, only if, he/she needs to manage this specific NAS device 
by a specific NAS Proxy service.  

¶ If this value is empty or doesn't exist, the value under the connector registry key will be 
used, if it is also empty or doesn't exist, the local machine name is used. 

 

6. The NAS device registry key in Hitachi edition is: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ NTPSoftware\ BCS\ ConnectedTitans\ <Device name> 

NOTES 

The following are the two registry values that the user might set in the registry per the 
NAS device, in addition to the ProxyServer registry value as described above.  

I. ApplicationPriority: NAS Proxy service orders registered applications based on 
priority. This registry value is a DWORD value that should contain the 
application priority according to which it will receive the requests from the 
registered NAS Proxy services, and its responses will be processed by those 
NAS Proxy services. The default value for this registry value is 4, and the 
minimum is 0 and the maximum is 100. If the user sets this registry value to 
any value outside this range, Control-QFS will set it automatically to the 
default value. 

II. ConnectionMaintPeriodInSec: A DWORD value that should contain the 
interval in seconds for the Connector service to check the status of its 
connection with the registered NAS Proxy services that is managing this NAS 
device. The default value for this registry value is 4 seconds, and the minimum 
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is 1 second and the maximum is 300 (5 minutes). If the user sets this registry 
value to any value outside this range, Control-QFS will set it automatically to 
the default value. 
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Adding an EVS to the DefendX Software Control-QFS Policy 
Hierarchy 
Next, you need to add your EVS to the collection of servers being managed by DefendX Software 
Control-QFS. 

1. Run DefendX Software Control-QFS Admin by clicking Start > Programs > DefendX Software 
Control-QFS for NAS > DefendX Software Control-QFS for NAS Admin. 

2. Right-click My Site and choose New > EVS. 

3. You will be prompted to enter a name. The name you enter here must match the name of 
your EVS. 

4. Now that you have added your EVS to the collection of servers recognized by DefendX 
Software Control-QFS, right-click the EVS you just added and select New > Quota & File 
Sentinel Application. 

Entries will appear under the EVS for disk quota and file control policies. 

5. Next, you need to associate the policies you will create here with an EVS. In the DefendX 
Software Smart Policy Manager hierarchy view (the left pane), click the plus sign (+) adjacent 
to the name of the Windows-based server on which you installed DefendX Software Control-
QFS. 

6. Right-click Quota & File Sentinel under that entry and select Properties to open the DefendX 
Software Control-QFS Configuration screen. 

7. Click the Hitachi Connector tab. 

8. Click the Add button. 

9. Enter the name of your EVS. 

10. Click OK. 

11. Click OK in the DefendX Software Control-QFS Configuration screen. 
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NRT (Near Real Time) Devices 

Unlike NAS devices in Control-QFS editions, NRT devices do not send notifications to the 
connector service. User actions occur on files/directories on the NAS device. Instead of real-time 
processing of user actions, an NRT connector performs periodic scanning on the managed 
directories of the NAS device, to apply some operations and policy enforcement. 

For example, a periodic scanning for a directory managed by Quota policy, finds that a managed 
user is over quota limit on that directory. In this case the Control-QFS connector service applies 
deny-write security configurations on that directory for this user. This means the user will not be 
able to add more files to that managed directory, which is the same result of denying write 
operations in real-time devices when the user exceeds the quota limit. 

The difference is that real-time devices such as Filers do not apply security configurations on the 
managed directory to enforce policies.  Instead the Filer notifies the connector about the user 
action (when the user is trying to add a file, for example) and the connector processes that user 
action at real time and reply to the Filer telling it to deny this user action. 

Since NRT devices are not real time, the user may still be able to write after they exceed the 
quota limit, until the next periodic scanning occurs. Periodic scanning can apply File Control 
Policies (FCPs) by either Delete or Quarantine files that match the policy criteria. Periodic 
ǎŎŀƴƴƛƴƎ Ŏŀƴ ōŜ ŎƻƴŦƛƎǳǊŜŘ ŦǊƻƳ ŀ ǊŜƎƛǎǘǊȅ ǾŀƭǳŜ ƴŀƳŜŘ άtŜǊƛƻŘƛŎ{ŎŀƴaƻŘŜέΣ ǘƘŀǘ ƛǎ ǳƴŘŜǊ ǘƘŜ 
NRT Connector registry key: 

 άIY9¸ψ[h/![ψa!/ILb9\SOFTWARE\NTPSoftware\bw¢έ 

It represents 3 different modes of re-scan, which depend on the number of days that should 
elapse between each two successive re-scanning for all managed directories, as in the table 
below. 

 

  



                                     Copyright © 2019 DefendX Software 
  22 

For more details of registry value, kindly check the table below: 

 Registry Key Expected values 

PeriodicScanMode 0 No periodic scans, just the initial one 
(on start) 

1 In addition to initial one, run scan at 
midnight (if scanning isn't already 
running) 

2 In addition to initial one, run scan on 
Friday's midnight (if scanning isn't 
already running) 
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Preparing EMC Isilon 

Refer to this section only if you have EMC Isilon devices attached to your environment. If you do 
not have EMC Isilon devices, you should not apply the instructions specified in this section. 

Preparing the EMC Isilon for DefendX Software Control-QFS 
Management 
To prepare the EMC Isilon, the following must be taken into consideration: 

1. Each Isilon managed by DefendX Software Control-QFS must join the same domain as the 
Control-QFS machine. 

2. The logon account used to register with the EMC Isilon (the account that will be assigned to 
the Control-QFS connector service) needs to be a member of the Isilon's local Administrators 
group. 
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Adding an Isilon to the DefendX Software Control-QFS Policy 
Hierarchy 
Next, you need to add your Isilon to the collection of servers being managed by DefendX Software 
Control-QFS. 

1. Run DefendX Software Control-QFS Admin by clicking Start > Programs > DefendX Software 
Control-QFS for NAS > DefendX Software Control-QFS for NAS Admin. 

2. Right-click My Site and choose New > Isilon. 

3. You will be prompted to enter a name. The name you enter here must match the name of 
your Isilon. 

4. Now that you have added your Isilon to the collection of servers recognized by DefendX 
Software Control-QFS, right-click the Isilon you just added and select New > Quota & File 
Sentinel Application. 

Entries will appear under the Isilon for disk quota, file control and file management policies. 

5. Next, you need to associate the policies you will create here with an Isilon. In the DefendX 
Software Smart Policy Manager hierarchy view (the left pane), click the plus sign (+) adjacent 
to the name of the Windows-based server on which you installed DefendX Software Control-
QFS. 

6. Right-click Quota & File Sentinel under that entry and select Properties to open the DefendX 
Software Control-QFS Configuration screen. 

7. Click the NAS Connector tab. 

8. Click the Add button. 

9. Enter the name of your Isilon. 

10. Click OK. 

11. Click OK in the DefendX Software Control-QFS Configuration screen. 
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Preparing Dell NAS 

Refer to this section only if you have Dell NASs attached to your environment. If you do not have 
Dell NASs, you should not apply the instructions specified in this section. 

Preparing the Dell NAS for DefendX Software Control-QFS 
Management 
To prepare the Dell NAS, the following must be taken into consideration: 

1. Each Dell NAS managed by DefendX Software Control-QFS must join the same domain as the 
Control-QFS machine. 

2. The logon account used to register with the Dell NAS (the account that will be assigned to the 
Control-QFS connector service) needs to be a member of the Dell NAS's local Administrators 
group. 
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Adding a Dell NAS to the DefendX Software Control-QFS Policy 
Hierarchy 
Next, you need to add your Dell NAS to the collection of servers being managed by DefendX 
Software Control-QFS. 

1. Run DefendX Software Control-QFS Admin by clicking Start > Programs > DefendX Software 
Control-QFS for NAS > DefendX Software Control-QFS for NAS Admin. 

2. Right-click My Site and choose New > Dell NAS. 

3. You will be prompted to enter a name. The name you enter here must match the name of 
your Dell NAS. 

4. Now that you have added your Dell NAS to the collection of servers recognized by DefendX 
Software Control-QFS, right-click the Dell NAS you just added and select New > Quota & File 
Sentinel Application. 

Entries will appear under the Dell NAS for disk quota, file control and file management 
policies. 

5. Next, you need to associate the policies you will create here with a Dell NAS. In the DefendX 
Software Smart Policy Manager hierarchy view (the left pane), click the plus sign (+) adjacent 
to the name of the Windows-based server on which you installed DefendX Software Control-
QFS. 

6. Right-click Quota & File Sentinel under that entry and select Properties to open the DefendX 
Software Control-QFS Configuration screen. 

7. Click the NAS Connector tab. 

8. Click the Add button. 

9. Enter the name of your Dell NAS. 

10. Click OK. 

11. Click OK in the DefendX Software Control-QFS Configuration screen. 
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User Group Resolution 

When a user makes a user action on a managed NAS device, the connector service sends this user 
SID to Control-QFS service to start resolving its user-group membership from Active Directory. 
The Control-QFS service works on resolving group membership recursively from Active Directory, 
by continuously contacting Active Directory to retrieve the groups to which the current account 
belongs, in Depth first strategy, to get the whole 'Member Of' information in a complete manner. 
After the service finishes the resolution of the received user SID, it starts sending all of these 
groups to the connector service. The connector service then caches this user SID with its group 
membership information for better performance, and maintenance is done periodically for this 
cached information. 

Group Group Resolution 

In Control-QFS service, the resolution procedure is extended to cache the group-group 
membership information after making user-group resolution for any user SID. A periodic 
maintenance is done concurrently on this cached information. This caching will enhance 
performance of user-group resolution mentioned above, because retrieving group membership 
from Active Directory will be done only once for each group on the 1st user action done by a user 
member of this group (either direct or indirect member) and it will be cached and maintained 
periodically, so any later resolution of group membership for the same group will be retrieved in 
no time from cache instead of retrieving it from Active Directory. At service shutdown, the 
Control-QFS service will save the cached group-group information in a file named 
'GrpGrpCache.dat' in the installation directory. 

Group Group Resolution Configuration 

The group-group resolution cache is to be configurable by some registry values. The following 
registry values will be added under the following Control-QFS service registry key: 

HKEY_LOCAL_MACHINE\ SOFTWARE\ NTPSoftware\ Quota Sentinel Service 

i. GrpGrpCacheRefreshMinutes: To configure the time period in minutes, according to 
which the cached resolution information is considered out-dated and needs to be 
updated again from Active Directory. The default value for this registry value is 30 
Minutes, and the minimum is 5 minutes and the maximum is 10080 minutes (one week), 
inclusive. If the user sets this registry value to any value outside this range, Control-QFS 
will set it automatically to the default value. 

ii. GrpGrpCacheExpireDays: To configure the time period in days, according to which the 
resolution information is considered not used and needs to be deleted. The default value 
for this registry value is 20 days and the minimum is 10 and the maximum is 150 days (five 
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months), inclusive. If the user sets this registry value to any value outside this range, 
Control-QFS will set it automatically to the default value. 

NAS Device Registeration Status 

The user can check the status of each managed NAS device displayed under its "Quota & File 
Sentinel" tree node. There are three different statuses with specific icons for each managed NAS 
device; Unknown, Managed, and Unmanaged. The icon of the status node changes according to 
the NAS device status as shown below: 

Icon Status Case 

 Unknown 
At Control-QFS Admin startup or when there is any failure in 
retrieving the status. 

 Managed When managed. 

 Unmanaged When unmanaged. 

 

When the tree node of the NAS device status is selected, the right-hand list view displays different 
information about the NAS device depending on the connection status: 

If the status is "Managed" the installed operating system on that NAS device will be displayed.  

If the status is "Unmanaged", the reason of connection failure to the NAS device will be displayed. 

 

NOTE: In case of the Managed status, the same is applied for EMC and Hitachi Editions, 
taking into consideration the name of the column i.e. 'Data Mover DART Version' in the 
case of the EMC Edition and 'EVS HOS Version' in the case of the Hitachi Edition. 
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At startup, the Control-QFS Admin displays the status of all managed NAS devices as 'Unknown' 
and the Filer ONTAP Version as 'Unknown'. Once the Admin retrieves the connection status of 
each managed NAS device, the data will be refreshed. The refresh rate is configurable in the 
"Misc. Options" tab in the άvǳƻǘŀ ŀƴŘ CƛƭŜ {ŜƴǘƛƴŜƭέ tǊƻǇŜǊǘƛŜǎ dialog box.  
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NOTES: 

¶ The default refresh rate is 30 seconds while the minimum rate is 10 seconds and the 
maximum rate is 1 hour (3600 seconds).  

¶ ¢ƘŜ ǊŜŦǊŜǎƘ ǊŀǘŜ Ŏŀƴ ōŜ ƛƴƘŜǊƛǘŜŘ ŦǊƻƳ ǘƘŜ Ǝƭƻōŀƭ άvǳƻǘŀ ŀƴŘ CƛƭŜ {ŜƴǘƛƴŜƭέ ƴƻŘŜ ƛƴ 
Control-QFS hierarchy. 

¶ IPs are written in the "cepp.conf" file of the host physical Data Mover, if their EMC 
CAVA services are connected with the control station. Any IP   that is written in the 
"cepp.conf" file but doesn't contain CEE or its CEE is not connected with the control 
station will not be listed. The 2nd column displays the last HeartBeat time received 
by the managing connector service from the corresponding EMC CAVA service. 
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Checking the Container Status  

The Container Status node summarizes the status of managed NAS devices under any container. 
It is displayed under the "Quota & File Sentinel" tree node of each container. According to the 
status of the managed NAS device(s) under that container, it can be in one of the following states: 

Icon  Status  Description  

 Unknown This is the default status, which will be displayed at startup, and when the 
status of any managed NAS device under that container is Unknown and 
none of them is Unmanaged. 

 Managed This is displayed when the status of all managed NAS devices under that 
container are Managed. 

 Unmanaged This is displayed when the status of any managed NAS device under that 
container is Unmanaged. 

 Not 
Applicable 

This is displayed when the container has no managed NAS device under it. 

At startup, the Control-QFS Admin displays the default status of the container, which is Unknown, 
until it retrieves the connection status of all managed NAS devices under it. Once the user selects 
the status node under any container, the connection status of all managed NAS devices or sub-
containers under it is listed on the right with some information about these NAS devices or sub-
containers.   
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NOTES ¶ The icon of the Container Status node is set according to the highest status 
severity of its managed NAS devices or sub-containers. The status severities 
are as follows in descending order from the most to least severe: Unmanaged 
status, Unknown status, Managed status. If a container is empty, then its 
status will be displayed as Not Applicable and it will be ignored in calculating 
its parent container status. 

¶ The Container status node is refreshed according to the statuses of the 
managed NAS devices. The refresh rate is configured from the 'Misc. Options' 
tab. 

¶ NRT NAS devices do not have a status node under its "Quota and File 
Sentinel" node, and as a consequence these devices will not be considered in 
computing the status of any container that contains them. NRT NAS devices 
will not be listed in the list of the managed NAS devices/sub-containers when 
their container status node is selected in the tree. 

¶ In case of EMC Celerra NAS device, the status validation will check that at 
least one IP of the Control-QFS connector machine IPs is present in the 
'servers=' section of the cepp.conf file, on the host PDM of the managed CIFS 
server. If the Control-QFS machine IP is missing, the status will be displayed 
as Unmanaged.  
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Diagnosing NAS Device Status 

The user is enabled to diagnose a managed NAS device in case it is Unmanaged, Unknown, or 
even Managed. During the diagnosis process, the Control-QFS Admin communicates with the 
Control-QFS services and they should be up and running on the connector machine. Control-QFS 
validates either Control-QFS Service or Connector Service statuses depending on the diagnosis.  
If any service is down the diagnosis will not start. 

NOTES: ¶ If there is a firewall controlling the Control-QFS connector machine, 
then it should open the ports used by Control-QFS services in order for 
Control-QFS to work properly e.g. receiving user actions occur on the 
managed NAS device and respond to them, sending emails, popups, 
wt/ Ŏŀƭƭǎ ōŜǘǿŜŜƴ ǎŜǊǾƛŎŜǎΧ ŜǘŎΦ 

¶ If the Control-QFS connector machine is controlled by firewall and any 
port is not opened, Control-QFS will try to open those ports. If Control-
QFS failed to open the ports, the Firewall Settings validation test will be 
marked as failed. 

To diagnose a NAS device status, perform the following steps:  

1. Right-click the Status node in the tree, under any managed NAS device. 

2. Select Diagnose menu item.  
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NOTES: The diagnosis process differs according to the NAS device type. The diagnosis 
has 2 forms based on the NAS device type: 

¶ For NetApp Filer and Hitachi EVS: a progress dialogue appears to notify 
the user about the validation test that is currently in progress. If all 
validation tests succeed, a completion message is eventually displayed. 

¶ For EMC Celerra CIFS Server: a sequence of dialogues is displayed, where 
each dialogue validate a certain aspect of EMC NAS device management 
requirements, and the user is allowed to move forward in the diagnose 
process or retry the current diagnosis step if failed, or even quit the 
whole diagnosis process. 
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Showing Advanced Configuration Parameters 

The Basic/Advanced configuration mode is a method of hiding/displaying more advanced 
configuration parameters from/to the user to prevent confusion and/or misconfiguration. All 
configuration parameters are categorized as either Basic or Advanced. By default, Control-QFS 
Admin is configured to run in Basic mode when first installed. The intent is to not even let the 
user know that the advanced parameters exist when in Basic mode. 

NOTES: ¶ The state of the Basic/Advanced mode will be stored in the Control-QFS 
Admin machine registry.   

¶ If the Control-QFS Admin is closed and reopened, the Basic/Advanced 
state will return to what it was before the Admin was closed. 

To show advanced configuration parameters, perform the following steps:  

1. From the Edit menu, select Show Advanced. 

 

2. In the warning dialog box, click Yes.   

  

A check mark will appear next to the Show Advanced menu item and the Admin will show all 
configuration parameters (basic and advanced) in all controls and dialogues. 

 

 

NOTE:  

 

 

To return to the Basic display mode, perform the following steps: 
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1. From the Edit menu, click the checked  Show Advanced menu item.  

2. In the warning dialog box, click Yes.  

 

.    
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Locking Configuration Parameters 

The user can set many Control-QFS configuration parameters to be "read only". When in the 
locked state, designated parameters cannot be changed but are visible through the Control-QFS 
Admin. This is typically accomplished by disabling the control that holds the configuration 
parameter. By default, Control-QFS Admin is configured to run in unlocked state when first 
installed. 

NOTE: The locking does not prevent users from changing configuration through the CLI 
or a script. 

To lock configurations, perform the following steps: 

1. From the Edit menu, select Lock Configurations. 

 

2. In the warning dialog box, click Yes.  

 

A check mark will appear next to the Lock Configurations menu item and the Admin will enter 
the locked state.   
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NOTE:  To return to the unlocked mode, perform the following steps: 

1. From the Edit menu, click the marked Lock Configurations menu item.  

2. In the Unlock Configuration dialog box, enter the password provided to you 
from DefendX Software  and click OK.  

 

 

Important: The locked state will be stored in EASE so all installed Control-QFS Admins will have 
access to the same state. When locked, all Admins will be locked. When unlocked, all Admins will 
be unlocked. 
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Relating Basic/Advanced Mode with Locking state 

The Basic/Advanced and Lock features are related to each other, because they both change how 
the user sees the UI and deals with it. Simply, the Basic/Advanced feature is responsible for 
showing/hiding some controls, while the Lock feature is responsible for disabling/enabling some 
controls. Both features can target the same control, and they will not overlap or conflict with 
each other.  

The rule of treating a configuration parameter grouping control in the same way as the 
configuration parameter itself will apply for any configuration parameter, if and only if the 
grouping control contains only one configuration parameter. If the grouping control contains 
more than one configuration parameter, then the grouping control will be disabled if all grouped 
controls are disabled, and it will be hidden if all grouped controls should be hidden. 

A tab-page can be categorized as a whole to be Basic or Advanced, and governed by the Lock 
feature or not. A tab-page categorized as Advanced will be completely hidden and will not appear 
in the tab-sheet. A tab-page governed by the Lock feature will have all its controls disabled if 
Control-QFS Admin is in locked state, and enabled otherwise. If a subset of a tab-page controls is 
explicitly categorized to be Basic or Advanced or governed by the Lock feature, then the other - 
non-categorized - configuration parameters are implied to be Basic parameters, or NOT governed 
by the Lock feature (i.e. not lockable). 

Following is a screen-shot for each tab-page containing a set of configuration parameters, with a 
categorization for each of its controls (i.e. configuration parameters) as Basic or Advanced, and 
which control is governed by the Lock feature (i.e. lockable). 
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Tab-page Screenshot Control Categorization 

Email 
Configuration 

 

Basic/Lockable 
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Tab-page Screenshot Control Categorization 

SNMP 
Configuration  

 

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Event Options  

 

 

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Security  

 

 

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Size Options 

 

 

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Dashboard 
Configuration 

 

  

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Misc. Options 

 

. 

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Disk Quota 
Policy :  
General 

 

 

 

 

"Always enforce this one": 

 Advanced/Lockable 

 

Disk Quota 
Policy: Quota 

 

In Basic mode. 

The Quota tab-page has 2 
exceptional behaviors, and they 
are as follows: 

The __% of Quota is disabled in 
Basic and enabled in Advanced 
mode. Which means that on 
creating a new Disk Quota Policy in 
Basic mode, the user only has the 
option to set a soft quota (i.e. keep 
Deny Writes un-checked) or set a 
hard limit fixed to 100% of Quota  - 
which is the default percentage. 
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Tab-page Screenshot Control Categorization 

Disk Quota 
Policy: 
Thresholds 

 

Nothing changes. 

 

Disk Quota 
Policy: 
Directories 

 

 

Quota limit is applied: 
Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

Disk Quota 
Policy: 
Exempted 
Subdirectories 

 

Advanced/Lockable 

 

Disk Quota 
Policy: Other 
Recipients 

 

 

Basic/Lockable 
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Tab-page Screenshot Control Categorization 

Disk Quota 
Policy: 
Managed 
Users and 
Groups 

 

 

Basic/Lockable 

Disk Quota 
Policy: 
Exempted 
Users and 
Groups 

 

Basic/Lockable 
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Tab-page Screenshot Control Categorization 

File Control 
Policy: General 

 

 

Nothing changes. 

File Control 
Policy: Criteria 

 

 

 

Zip Scan: Advanced/Lockable; 
unchecked is default 

Deep Scan: Advanced/Lockable; 
unchecked is default 

Disposition: Advanced/Lockable; 
Manage is default 
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Tab-page Screenshot Control Categorization 

File Control 
Policy: Criteria 

 

Basic/Lockable 

 

File Control 
Policy: 
Directories 

 

 

Nothing changes. 
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Tab-page Screenshot Control Categorization 

File Control 
Policy: 
Exempted 
Subdirectories 

 

 

Basic/Lockable 

File Control Policy: Managed Users 
and Groups tab-page: 
Basic/Lockable. 

File Control Policy: Exempt Users 
and Groups tab-page: 
Basic/Lockable 

File Control Policy: Other 
Recipients tab-page: 
Basic/Lockable 

 

File 
Management 
Policy: General 

  

This file policy is dependent on the 
folder policy: Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

File 
Management 
Policy: Criteria 

 

Deep Scan & Zip Scan: 
Advanced/Lockable 

Delete Action option: 
Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

File 
Management 
Policy: Alerts 

 

Advanced/Lockable 

File 
Management 
Policy: 
Thresholds 

 

Advanced/Lockable 
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Tab-page Screenshot Control Categorization 

File 
Management 
Policy: 
Directories 

 

Nothing changes. 

File Management Policy: 
Exempted Subdirectories: 
Basic/Lockable 

File Management Policy: Managed 
Users and Groups: Basic/Lockable 

File Management Policy: Exempt 
Users and Groups: Basic/Lockable 

File Management Policy: Other 
Recipients: Basic/Lockable 
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DefendX Software Control-QFS System Dashboard (QSD) 

DefendX Software Control-QFS System Dashboard, referred to as QSD, is an add-on to DefendX 
Software Control-QFS. It is a web application that provides administrators with a high level of 
statistical information on their DefendX Software Control-QFS environment. This reporting tool 
is efficient for administrators because it provides critical information about the entire DefendX 
Software Control-QFS environment. 

NOTE: Control-QFS for Windows does not support QSD. 

 

 

For QSD to report on your environment, you need to perform the following: 

1. Run DefendX Software Control-QFS Admin by clicking Start > Programs > DefendX Software 
Control-QFS for NAS > DefendX Software Control-QFS for NAS Admin. 

2. Right-click Quota & File Sentinel under the main Windows server. 

3. Click Properties on the pop-up menu. 

4. On the Dashboard Configuration tab, clear the box Inherit Control-QFS Dashboard 
Configuration and check the box Enable Control-QFS Dashboard. 
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5. Add the following information and then click OK: 

Field Description 

Dashboard URL Enter the following URL: http://webservername/Control-
QFSSystemDashboardWebService/QSDWS.asmx 

HTTP user logon Enter the HTTP username. 

HTTP user password Enter the HTTP password. 

Proxy host Enter the proxy host. 

Proxy port Enter the proxy port. 

Frequency This decides how frequently DefendX Software Control-QFS 
collects information to the web service, when the database is 
filled so as the website displays such data. This could be 
configured as follows: 

¶ High Frequency: 1 minute (DefendX Software Control-
QFS will keep    sending the collected data out of the 
ǳǎŜǊǎΩ ǘǊŀƴǎŀŎǘƛƻƴǎ ŜǾŜǊȅ м ƳƛƴǳǘŜύΦ 

¶ Medium Frequency: 15 minutes (DefendX Software 
Control-QFS will keep sending the collected data out of 
ǘƘŜ ǳǎŜǊǎΩ ǘǊŀƴǎŀŎǘƛƻƴǎ ŜǾŜǊȅ мр ƳƛƴǳǘŜǎύΦ 

¶ Low Frequency: 30 minutes (DefendX Software Control-
QFS ǿƛƭƭ ƪŜŜǇ ǎŜƴŘƛƴƎ ǘƘŜ ŎƻƭƭŜŎǘŜŘ Řŀǘŀ ƻǳǘ ƻŦ ǘƘŜ ǳǎŜǊǎΩ 
transactions every 30 minutes). 

  

 

NOTE: The HTTP username and password should be the same as the DefendX Software 
Control-QFS service account. 

 

6. Click OK in the DefendX Software Control-QFS Configuration screen. 
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Setting the DefendX Software Control-QFS Application 

Properties 

1. Right-click Quota & File Sentinel under the main Windows server. 

2. Click Properties on the pop-up menu. 

3. On the Email Configuration tab, clear the Inherit Email Configuration box, check the Enable 
Email Notifications box, enter the correct information in each of the four text boxes as 
appropriate for your network, and click OK. 

4. bƻǿΣ ƭŜǘΩǎ ƳƻǾŜ ƻƴ ǘƻ ŎƻƴŦƛƎǳǊƛƴƎ {ƛƳǇƭŜ bŜǘǿƻǊƪ aŀƴŀƎŜƳŜnt Protocol (SNMP), which 
helps to manage complex networks. Click the SNMP Configuration tab. Clear the box Inherit 
SNMP Configuration, check the Enable SNMP Messages box, enter the SNMP console IP 
address that will be used to monitor the network, enter the community name, and click OK. 

5. Click the Event Options tab and clear the Inherit Options box. 

6. Next, we will configure the desired quota threshold and file management threshold events. 
Quota thresholds post events when falling below thresholds, when exceeding thresholds, or 
both. Check the desired settings in the Quota Threshold Events section of the dialog box. File 
management thresholds post events for file management time remaining thresholds, file 
deletion operations, or both. Check the desired settings in the File Management Threshold 
Events section of the dialog box. 

7. Click the Security tab. Clear the Inherit Security box and check the Enable Security box. Click 
Add to choose the members or groups for which you want to apply security options. 

NOTE: In the Non-Owner Permissions section of the dialog box, choose the desired 
settings for the types of policies and properties. 

 

8. Click the Hitachi Connector tab to add/remove the Hitachi NAS(es) to be managed by the 
Hitachi Connector, quarantine/delete prohibited files, and enable/disable file-blocking 
recovery.  

o The share Control-QFSQuarantine or Control-QFSQuar must exist on each managed 
machine so Quarantine can work properly. 

o ¢ƘŜ vǳŀǊŀƴǘƛƴŜ ŀƴŘ 5ŜƭŜǘŜ ƻǇǘƛƻƴǎ ǿƻǊƪ ǿƛǘƘ 5ŜŜǇ{Ŏŀƴϯ ŀƴŘ ½ƛǇ{ŎŀƴϰΣ ǎƻ ƛŦ ŀ ŦƛƭŜ ƛǎ 
considered "denied" after it was deep-scanned or zip-scanned, it will be deleted or 
quarantined depending on the selected option. 
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o Enabling the file-blocking recovery settings allows quarantining or deleting the 
prohibited files by DefendX Software Control-QFS file control policies that were 
copied while the DefendX Software Control-QFS Connector service wasn't running. 
This can happen if the Control-QFS machine was rebooted or shutdown for any 
reason. 

9. Click the Misc. Options tab to configure daily email reminders for users who are at or near 
quota, directory connector properties (for resolving email addresses), and tuning properties, 
which control how DefendX Software Control-QFS sizes objects at system startup. 

o The daily reminder feature works in conjunction with the Send to Triggering User 
setting on the General tab of the Threshold Properties dialog box. If you're not 
sending email notifications to users when an object reaches its quota, the daily 
reminder setting has no effect, whether you've enabled it or not. 

o If the AM/PM field is set to AM, and you enter 12-23 (military time) in the Hour field, 
the AM/PM field changes to PM, and the hour adjusts itself to regular time (12-11 
PM). 

o The Inherit Directory Connector Properties option works in conjunction with the 
Email Configuration tab on the DefendX Software Control-QFS Configuration dialog 
box. If you disable email notifications on the Email Configuration tab, the following 
options are also disabled. 
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Sizing Options  

DefendX Software Control-QFS allows administrators to decide whether to calculate space using 
the logical size of files or the physical size of files, where space calculation using logical size is 
determined by the size of the data found in files and space calculation using physical size is 
determined by the actual amount of disk allocation units the file consumes. So physical sizing 
simply refers to the size on disk. This can be performed as follows: 

1. Right-click Quota & File Sentinel under the main NAS device or a non-Windows server 
container. 

2. Click Properties on the pop-up menu. 

3. On the Size Options dialog box, clear the Inherit Size Options box if you want to set the sizing 
option individually on a NAS device. In this case, you need to choose whether to calculate 
ǳǎƛƴƎ ŜŀŎƘ ŦƛƭŜΩǎ ƭƻƎƛŎŀƭ ǎƛȊŜ ŦƻǊ ŀƭƭ ŦƛƭŜǎ ƻǊ ŎŀƭŎǳƭŀǘŜ ǳǎƛƴƎ ŜŀŎƘ ŦƛƭŜΩǎ ǇƘȅǎƛŎŀƭ ǎƛȊŜ ŦƻǊ ŀƭƭ ŦƛƭŜǎΦ  

o If the size option is changed, this will force a resize operation to occur on the NAS 
device. DefendX Software Control-QFS will continue to enforce quotas based on the 
previous size selection until the resize operation is complete. 

o The default size option is a logical sizing option. 

o The sizing option is not available on Windows hosts machines. Logical sizing is used 
for all Windows hosts. 

NOTE: While Control-QFS for NAS can size by logical or physical file sizes, Control-
QFS for Windows cannot.   
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Policy Creation 

This section outlines standard DefendX Software Control-QFS procedures for creating policies. 

Please note:  

¶ DefendX Software Control-QFS manages two main types of paths: directory paths and share 
paths. For share paths, all you need to do is add a share name. For directory paths, the format 
depends on the DefendX Software Control-QFS edition being used.  

o For NAS NetApp edition, the directory path format is \vol\<volume name>\<some 
ŘƛǊŜŎǘƻǊȅҔώΧ\optional subdirectory\another optional subdirectory]  

o For NAS EMC, the directory path format is \<file system mount path>\<some 
ŘƛǊŜŎǘƻǊȅҔώΧ\optional subdirectory\another optional subdirectory] 

o For Hitachi edition, the directory path format is \ fs\<volume name>\<some 
ŘƛǊŜŎǘƻǊȅҔώΧ\optional subdirectory\another optional subdirectory]  

o For Windows edition, the directory path format is Drive:\<some 
ŘƛǊŜŎǘƻǊȅҔώΧ\optional subdirectory\another optional subdirectory]  

Examples:  d:\private\marketing or d:\users\*  

¶ Directory paths can have different behavior by putting a star '*' instead of one of the directory 
names. This type of path forms a star policy, which can be used to manage all directories in 
the level of the '*'. 

Important: As Control-QFS for NAS allows the use of * in the middle of a managed path, 
Control-QFS for Windows does not. 

When testing policies you have created, perform the tests from an independent machine that 
is not running DefendX Software Control-QFS. 
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Creating Disk Quota Policies 
This section walks you through creating a typical disk quota policy. We will create a quota policy 
for all your user home directories in a typical server configuration. This quota policy will be 
applied to all users in your Users directory. Each user will get a quota limit of 50MB. 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the server/Filer/CIFS 
Server/EVS you added earlier. If necessary, click the plus sign (+) adjacent to this entry to 
expand the tree. Then click the plus sign next to Quota & File Sentinel to expand the policy 
types. 

2. Right-click Disk Quota Policies and select New > Folder Policy Using Directories. 

3. In the New Policy dialog box, click the General tab. Enter a name and a description for your 
new policy. 

4. Click the Quota tab, select Absolute Quota Limit, enter 50 MB as the limit, click Deny Writes 
at 100% of quota, and leave Overdraft unchecked for this example. 

NOTE: In a production environment, it is a best practice to implement a 10% 
overdraft. 

 

5. Click the Thresholds tab to view the thresholds for this quota policy. Notice that one 
threshold is already set up: At Quota 100%. Adding more thresholds is as simple as clicking 
Add and filling in the percentage information for that threshold. 

As space is consumed, these thresholds serve as triggers for various actions. Each threshold can 
send email or pop-up messages to the triggering user, the NTFS owner of the file, and/or to any 
other group or individual (network administrators, the Help Desk, and so on). A threshold can 
also run a third-party processς for example, running a virus scan on the file in question, or starting 
an archive to tape. 

DefendX Software Control-QFS lets you create up to 200 threshold levels for each policy. 
Common choices for additional levels are 75%, 85%, and 95%. As users hit each of these levels, 
you can customize your messages to suggest that users delete some files or contact the Help 
Desk and request a quota increase before their ability to save new documents runs out. It is also 
possible to integrate DefendX Software Control-QFS with your intranet or automated workflow 
and process the limit increase automatically. 

6. Double-click the At Quota 100% threshold. The Threshold Properties dialog box for that 
threshold level appears. If you configured DefendX Software Control-QFS for email earlier, 
select the checkbox for email to the triggering user. 

The Messages tabs let you customize the text of the messages that will be sent. 
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The Threshold Commands tab allows you to specify a program, script, or batch (.BAT) file that 
will run when the threshold is reached. 

7. After you have chosen the appropriate settings for email and messages, click OK to return to 
the New Policy dialog box. 

8. Click the Directories tab. Click the Add button, type the appropriate directory path for your 
Users directory followed by a backslash and asterisk (\ *), or type the directory path with an 
asterisk (\ *) in the middle of the path to manage a subpath under each user directory. For 
asterisks in the directory path, only one asterisk is allowed. 

Important: As Control-QFS for NAS allows the use of * in the middle of a managed path, 
Control-QFS for Windows does not. 

NOTE: By default, this quota applies to all users. You can verify this fact by clicking 
the Managed Users and Groups tab. 

Administrators, Backup Operators, Replicator, and the System account are exempt from quotas. 
You can verify this fact by clicking the Exempt Users and Groups tab. To change this setting, select 
the appropriate entry and click Remove. 

9. Click the Exempted Directories tab. Click the Add button, type the subdirectory you want to 
exempt from the managed directories list. 

NOTES:  

¶ Asterisks * are not supported to be part of the exempted path. 

¶ While Control-QFS for NAS can exclude directories from quota policies, Control-
QFS for Windows cannot.   

 

10. Click OK to close the New Policy dialog box. DefendX Software Control-QFS will create the 
new quota directory policy, which will be inherited by all systems from this point down in 
your hierarchy. 
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Creating File Control Policies 
This section shows you how to create a file control policy. Perhaps your company has a corporate 
policy that forbids downloading music files from the Internet. To help the staff comply with this 
ǇƻƭƛŎȅΣ ƭŜǘΩǎ ŎǊŜŀǘŜ ŀ ŦƛƭŜ ŎƻƴǘǊƻƭ ǇƻƭƛŎȅ ǘƘŀǘ ǇǊƻƘƛōƛǘǎ ŎǊŜŀǘing music files on the server. 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the server/Filer/CIFS 
Server/EVS you added earlier. If necessary, click the plus sign (+) adjacent to this entry to 
expand the tree. Then click the plus sign next to Quota & File Sentinel to expand the policy 
types. 

2. Right-click File Control Policies and select New > Folder Policy Using Directories. 

3. The New File Control Policy dialog box opens. Give your policy a name and description. 

4. Click the Criteria tab. Then click Add and enter the file patterns you want to block (for 
example, *.AVI, *.MP3, *.MPG, *.MP2, and *.VBS). 

NOTE: Be sure to include the asterisk and period (*.) when you specify a file type. 

DefendX Software Control-QFS follows the normal Windows rules for wildcard file specifications. 
For example, enter *.MP? to include .MP3, .MP2, .MPG, etc. τ all music files. 

Important: As Control-QFS for NAS allows the use of * in the middle of a managed path, 
Control-QFS for Windows does not. 

This tab also includes two options, Block Zip files containing prohibited content and Enable 
DefendX Software DeepScan Technology, which enable the administrator to decide how 
thoroughly files are scanned for the policy. See the following sections of this document for more 
detailed information on these features. 

5. Click OK to return to the New File Control Policy dialog box. 

6. Click the Directories tab. Click the Add button, and either type the directory path or type the 
appropriate directory name followed by a backslash and asterisk (\ *). 

7. Click the Control Options tab. Because our policy is to prevent the creation of these files, 
select the radio button labeled Always Deny under the options Open for Read, Open for 
Write, and Create New. 

8. By default, user accounts with Administrator privileges are exempt from any policy you 
create. If you want to change this setting, click the Exempt Users and Groups tab, select the 
Administrators entry, and click Remove. 

9. Click OK to save this policy. 
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Creating File Management Policies 
This section walks you through creating a file management policy. Your company may have a 
corporate policy that allows your employees to store files in a central or shared location. As an 
administrator, you are responsible for maintaining the data stored in this location, which includes 
ŘŜƭŜǘƛƴƎ ƻƭŘ ƻǊ ƻōǎƻƭŜǘŜ ŘŀǘŀΦ [ŜǘΩǎ ŎǊŜŀǘŜ ŀ ŦƛƭŜ ƳŀƴŀƎŜƳŜƴǘ ǇƻƭƛŎȅ ǘƘŀǘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ƳŀƴŀƎŜǎ 
aged files. 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the server/Filer/CIFS 
Server you added earlier. If necessary, click the plus sign (+) adjacent to this entry to expand 
the tree. Then click the plus sign next to Quota & File Sentinel to expand the policy types. 

2. Right-click File Management Policy and select New > Folder Policy Using Directories. 

3. The New File Management Policy dialog box opens. Give your policy a name and description. 

4. Click the Criteria tab. Set the aspects of the policy: file patterns to remove, age of the files, 
size, and archive status. You can also select a specific action to take for the filesς for example, 
allowing audit, quarantine, or removal when the policy is triggered. Specify when to enforce 
the policy and whether it will be applied retroactively to files created before the policy. 

NOTE: ²ƘŜƴ ǘƘŜ ŦƛƭŜ ƳŀƴŀƎŜƳŜƴǘ ǇƻƭƛŎȅ ƛǎ ŎƻƴŦƛƎǳǊŜŘ ǘƻ άǊŜƳƻǾŜέ ƻƭŘ ƻǊ ƻōǎƻƭŜǘŜ 
date, it will remove empty directories after processing them. If a managed directory 
was not empty and the file removal policy controlling it has deleted all files in the 
managed directory, the policy will remove this directory if the Remove Empty 
Directories option is checked. 

5. Click the Alerts tab. As desired, turn on alerts for the quarantine and deletion of files. Once 
the alert is enabled, you have the option of enabling email (if the email server has been 
configured). 

6. Click OK to save the policy. 



                                     Copyright © 2019 DefendX Software 
  67 

Viewing Directories 
This section shows how you can view all the directories that are located on a certain server, Filer, 
CIFS Server, Titan, or Hitachi NAS. 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the server, Filer, or CIFS 
Server containing directories you want to view. If necessary, click the plus sign (+) adjacent to 
this entry to expand the tree. 

2. Click the plus sign next to Quota & File Sentinel. 

a. For the Windows server, click the plus sign (+) next to Server Directories to view the 
folders located on that server. 

b. For the Filer, click the plus sign (+) next to Filer Directories to view the volumes located 
on that Filer. 

NOTE: You can view that feature if you have a NetApp Filer attached to the 
DefendX Software Control-QFS application. 

c. For the CIFS Server, click the plus sign (+) next to CIFS Server Directories to view the 
file systems located on that CIFS Server. 

NOTE: You can view that feature if you have an EMC CIFS Server attached to the 
DefendX Software Control-QFS application. 
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Viewing Shares 
This section shows how you can view all the shared directories located on a certain server, Filer, 
or CIFS Server. 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the server, Filer, or CIFS 
Server with shared directories you want to view. If necessary, click the plus sign (+) adjacent 
to this entry to expand the tree. 

2. Click the plus sign (+) next to Quota & File Sentinel. 

d. For the Windows server, click the plus sign (+) next to Server Shares to view the shared 
folders located on that server. 

e. For the Filer, click the plus sign (+) next to Filer Directories to view the volumes located 
on that Filer. 

NOTE: You can view that feature if you have a NetApp Filer attached to the 
DefendX Software Control-QFS application. 

f. For the CIFS Server, click the plus sign (+) next to CIFS Server Shares to view the shared 
folders located on that CIFS Server. 

NOTE: You can view that feature if you have an EMC CIFS Server attached to the 
DefendX Software Control-QFS application. 
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DefendX Software DeepScan® 

A powerful feature of DefendX Software Control-QFS is DefendX Software DeepScan®. This 
technology allows the administrator to specify whether to use the default scan for file extensions, 
or scan deeper for header information to determine the true nature of a file. 

Before selecting Enable Deep Scan Technology on the Criteria tab in the New File Policy dialog 
box, it is important that you understand how this function will affect your data and user 
community. 

DefendX Software DeepScan uses file header information to determine the type of file. Even if 
the file Sunshine on My Shoulder.mp3 is renamed Sunshine on My Shoulder.txt, it will be seen 
and controlled as an audio (.MP3) file. Likewise, Lion.jpg may be renamed to Lion.txt, but it still 
will be seen and controlled as a .JPG file. DefendX Software DeepScan does this by looking at the 
ŦƛƭŜΩǎ ǘȅǇŜΦ ! ΦWtD ŦƛƭŜ ƛǎ ƛƴ Wt9D ƛƳŀƎŜ ŦƻǊƳŀǘΣ ǎƻ ƛǘ ǿƛƭƭ ƴƻǘ ƳŀǘǘŜǊ ǿƘŜǘƘŜǊ ǘƘŜ ŦƛƭŜ Ƙŀǎ ǘƘŜ 
extension .JPG, .JPEG, or .TXT. 

DefendX Software DeepScan supports the following file types: 

¶ Audio Files. DefendX Software DeepScan supports audio files with extensions .AIF, .AIFF, .IFF, 
.AU, .SND, .CDA, .WMA, .ASF,.MIDI, .FLAC, .OGG, .RMI, .RA, .RAM, .RM, and .AA 

¶ Video files. DefendX Software DeepScan supports video files with extensions .MOV, .QT, 
.MPEG, .MPG, .WMV, .ASF, .M4V, .RM. 

¶ Other files. DefendX Software DeepScan supports files with extensions .M3U, .MID, .M4V, 
.MPEG4, .MPEG2, .RAR, .MP33, .MP3A, .MP3B. 

Some notable items regarding DefendX Software DeepScan operations are the following: 

¶ Microsoft Office files. Microsoft Office applications store documents as OLE structured 
storage files (known as compound files). Microsoft Office recognizes Office files regardless of 
extension (.PST, .DOC, .XLS, etc.), and they are all treated as the same file type. This 
characteristic prevents DefendX Software Control-QFS from being able to block .PST files 
while allowing .DOC files, for example, when DefendX Software DeepScan is enabled. The 
.DOC file is seen as the same file type as the blocked .PST and is also blocked. If the 
administrator adds .DOC to managed files, DefendX Software Control-QFS will also manage 
other Office files in the same manner. 

¶ Microsoft Office 2007 files. Those files are real .ZIP files. So, if .ZIP files are to be controlled 
by the DefendX Software DeepScan, the MS Office 2007 files will be controlled under the 
category of .ZIP files, too. 
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¶ Text files. When forming your file control strategy, bear in mind that a .VBS or .BAT file is a 
text format file. With DefendX Software DeepScan enabled, DefendX Software Control-QFS 
will manage them (and similar text file extensions) in the same manner as .TXT files. 

¶ Google Earth Keyhole markup files. The same limitation that applies on MS Office 2007 files 
applies on Google Earth Keyhole markup files. 

¶ Windows installer files. MSI files will be recognized as MS Office files because of the format 
MS implemented them in. 

To enable DefendX Software DeepScan, perform the following steps: 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the Filer or CIFS Server 
you added earlier. If necessary, click the plus sign (+) adjacent to this entry to expand the 
tree. Then click the plus sign (+) next to Quota & File Sentinel to expand the policy types. 

2. Expand the File Control Policies. Then right-click the desired file control policy and select 
Properties. 

3. Click the Criteria tab. Check the Enable NTP Deep Scan Technology option to control how 
thoroughly files are scanned for the policy. 
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DefendX Software ½ƛǇ{Ŏŀƴϰ 

Another powerful feature of DefendX Software Control-QFS is DefendX Software ½ƛǇ{ŎŀƴϰΦ LŦ ǘƘƛǎ 
option is selected, DefendX Software Control-QFS looks for managed file types inside compressed 
files with the .ZIP extension. For example, entering the .MP3 file type and selecting Block Zip files 
containing prohibited content on the Criteria tab in the New File Policy dialog box will block files 
named .MP3 within a .ZIP file. 

Blocking .ZIP files is performed by examining the list of contents for the .ZIP file. With current 
technology, adding a third level of scanning could negatively impact file operations. When polling 
the industry, we found that most customers were not particularly concerned with renamed files 
within .ZIP files because users would find using those renamed files to be cumbersome enough 
to outweigh any benefits they would gain. 

To enable DefendX Software ZipScan, perform the following steps: 

1. In the DefendX Software Smart Policy Manager hierarchy view, locate the Filer or CIFS Server 
you added earlier. If necessary, click the plus sign (+) adjacent to this entry to expand the 
tree. Then click the plus sign (+) next to Quota & File Sentinel to expand the policy types. 

2. Expand the File Control Policies. Right-click the desired file control policy and select 
Properties. 

3. Click the Criteria tab. Check the Block Zip files containing prohibited content option to 
specify how thoroughly files are scanned for the policy. 
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DefendX Software 9ƴŘ ¦ǎŜǊ {ǳǇǇƻǊǘ LƴŦǊŀǎǘǊǳŎǘǳǊŜϰ 

(DefendX Software 9¦{Lϰύ 

DefendX Software 9ƴŘ ¦ǎŜǊ {ǳǇǇƻǊǘ LƴŦǊŀǎǘǊǳŎǘǳǊŜϰ όDefendX Software 9¦{Lϰύ ƛǎ ŀƴ ƛƴǘŜƎǊŀǘŜŘ 
component of DefendX SoftwareΩǎ Control-QFS application. EUSI contains several utilities to aid 
network administrators in informing users about what constitutes a quota violation and to assist 
users in fixing the problem. 

To install DefendX Software EUSI, insert the DVD and select the installation option from the install 
interface. Follow the prompts to install the various components: 

¶ DefendX Software Control-QFS Email Templates. Install these components on the same 
server as DefendX Software Control-QFS. 

¶ DefendX Software Storage HelpSite. This collection of web pages describes what each quota 
policy violation means. Its purpose is to help users understand why they were notified about 
a quota violation, to reduce the amount of time administrators spend answering these simple 
questions. 

¶ DefendX Software EUSI website. This site allows users to see what policy they violated, 
request policy changes, and clean up their drives. 

The DefendX Software Storage HelpSite, EUSI website, and DefendX Software Storage 
LƴǾŜǎǘƛƎŀǘƻǊϰ ŎƻƳǇƻƴŜƴǘǎ ǎƘƻǳƭŘ ōŜ ƛƴǎǘŀƭƭŜŘ on an intranet web server. The DefendX Software 
Control-QFS Email Templates component should be installed on the server in which DefendX 
Software Control-QFS is installed. 

Three dialog boxes are of particular importance in the installation process: 

¶ Virtual Directory. When the DefendX Software Storage HelpSite and DefendX Software EUSI 
website are installed on a web server, the installation creates virtual directories. By default, 
the directories are named HelpSite and EndUserSupportWebSite. You can change these 
default names in the Virtual Directory dialog box. 

¶ Hosting URL. Use this dialog box to specify the URL of the web server that hosts the DefendX 
Software Storage HelpSite and DefendX Software EUSI website. For example, use the 
following addresses: 

http://10.10.2.40 

http://intranetserver 

This address is used by the DefendX Software Control-QFS Email Templates component to access 
the websites. 
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¶ E-mail Options. In this dialog box, the Recipient is the mailbox to which quota change requests 
should be sent. One feature of the DefendX Software EUSI website is the capability for users 
to email requests for quota policy changes. The SMTP server is the address of the email server 
to use. 

 



                                     Copyright © 2019 DefendX Software 
  74 

DefendX Software Control-QFS Email Templates 

DefendX Software Control-QFS Email Templates are preformatted HTML email messages that can 
be imported easily into DefendX Software Control-QFS. The following email templates are 
provided: 

¶ BelowThreshold. Indicates that the user has gone below quota and is now allowed to save 
things to the share name again. 

¶ FileBlocked. Indicates that a particular file was blocked from being stored on a network share. 
This message might indicate a prohibited extension (such as .MP3) or some other blocking 
reason specified in the DefendX Software Control-QFS policy. 

¶ hǾŜǊvǳƻǘŀΦ LƴŘƛŎŀǘŜǎ ǘƘŀǘ ŀ ǳǎŜǊΩǎ ŀŎǘƛƻƴ Ƙŀǎ ŎŀǳǎŜŘ Ƙƛǎ ƻǊ ƘŜǊ ǎǘƻǊŀƎŜ ǘƻ ŜȄŎŜŜŘ ǉǳƻǘŀΦ ¢Ƙƛǎ 
particular message contains links to both the DefendX Software Storage HelpSite and the 
DefendX Software EUSI website. The OverQuota email message automatically passes the 
server and share name of the drive on which the quota was violated. To change this setting, 
see the DefendX Software Control-QFS documentation for valid keys. 

¶ FileRemoval. Indicates that a particular file of a user has been removed by a file removal 
policy. 

NOTE: When installing the DefendX Software Control-QFS Email Templates, it is 
very important that you specify URLs for the DefendX Software Storage HelpSite 
and the DefendX Software EUSI website. The default web pages have placeholders 
for these URLs. If you do not specify the addresses, the email templates will not 
function as designed. 
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Adding an Email Template to DefendX Software Control-QFS 
1. Open the DefendX Software Control-QFS Admin tool. Select the policy to which you want to 

add email; then choose File > Properties. 

2. Click the Thresholds tab. 

 

3. Select HTML as the message format and then click the Properties button. 

4. In the Threshold Properties dialog box, you can customize messages for each type of 
recipient. For this example, we want to send email only to the user who triggered the quota. 
In the Send to Triggering User section of the dialog box, select Email as the notification 
method. 
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5. Click the Triggering User Messages tab. 

 

6. In the section Above or Write Denied Threshold Message, click the Edit Text button to open 
a text editor. In the text editor, choose File > New to remove all existing text. 
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7. Choose Insert > File. Browse to the directory where DefendX Software EUSI website was 
installed and open the file OverQuota.htm. 

 

8. Click File, Save, & Close. 

9. Click OK as needed to exit the dialog boxes. Now, when a user goes over quota, he or she will 
receive an email message explaining that the quota limit has been reached on that server. 
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Specifying a File Control Message 
1. After creating a file control directory policy, click the Control Options tab in the New File 

Control Directory Policy dialog box. 

2. In the Messages section of the dialog box, select HTML. Then click the Message Text and 
Actions button. 

 

3. In the File Control Messages and Actions dialog box, click the General tab and select Email 
as the notification method in the Send to Triggering User section of the dialog box. 
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4. Click the Triggering User Messages tab. In the File Control Deny Message section of the 
dialog box, click the Edit Text button to open a text editor. In the text editor, choose File > 
New to remove all existing text. 

 

5. Choose Insert > File. Browse to the directory where DefendX Software EUSI website was 
installed and open the file FileBlocked.htm. 
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6. Click File, Save, & Close. 

7. Click OK as needed to exit the dialog boxes. Now, when a user tries to copy a blocked file, he 
or she will receive an email message. 
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DefendX Software Storage HelpSite 
The DefendX Software Storage HelpSite provides web pages that answer the most basic 
questions about DefendX Software Control-QFS policies and violations. The idea is to take this 
burden away from the network administrator and put the information in one central place. The 
DefendX Software Control-QFS Email Templates contain links to the DefendX Software Storage 
HelpSite so that when a user triggers an DefendX Software Control-QFS policy, he or she can 
quickly obtain information about the policy and how to fix the problem. 

The DefendX Software Storage HelpSite should be installed on a local web server. The installation 
process takes care of creating the virtual directory within IIS. 

DefendX Software End User Support Infrastructure Website 
This website contains pages that allow the user to perform the following: 

¶ Download DefendX Software Storage Investigator for cleaning up the user's directories. 

¶ Email the network administrator, requesting a change to the user's policy. 

The website is accessible from the DefendX Software Control-QFS Email Templates files. During 
the installation of DefendX Software EUSI, you will be prompted for the name of the virtual 
directory that should be created. This component should be installed on a web server. 
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DefendX Software {ǘƻǊŀƎŜ LƴǾŜǎǘƛƎŀǘƻǊϰ 
DefendX Software {ǘƻǊŀƎŜ LƴǾŜǎǘƛƎŀǘƻǊϰ ƛǎ ŀ ǘƻƻƭ ǘƻ ƘŜƭǇ ǳǎŜǊǎ clean up their shares and 
directories in order to avoid violating storage policies. DefendX Software Storage Investigator 
shows all files sorted by various criteria, such as the following: 

¶ Largest files 

¶ Oldest files 

¶ Duplicate files 

¶ Aged files 

¶ Extensions 

DefendX Software Storage Investigator is an ActiveX control that is set up to download from 
CleanupFiles.asp on the DefendX Software EUSI website. Due to the nature of ActiveX controls, 
the user must be an administrator on the local machine to download and register the ActiveX 
control. For environments in which users are not administrators on their local machines, an .MSI 
file is proviŘŜŘΦ ¢Ƙƛǎ ŦƛƭŜ Ŏŀƴ ōŜ ǳǎŜŘ ǿƛǘƘ !ŎǘƛǾŜ 5ƛǊŜŎǘƻǊȅ ƻǊ ƻǘƘŜǊ ǘƻƻƭǎ ǘƻ άǇǳǎƘέ ŀƴ ƛƴǎǘŀƭƭŀǘƛƻƴ 
of DefendX Software Storage Investigator to each machine. Once the DefendX Software Storage 
Investigator ActiveX control is installed and registered, users can run the control. 

For more information on configuring DefendX Software Storage Investigator, see DefendX 
Software Storage Investigator Parameters Reference. For more information on using DefendX 
Software Storage Investigator, see DefendX Software Storage Investigator User Manual. 

 



                                     Copyright © 2019 DefendX Software 
  83 

Administering DefendX Software Control-QFS Service 

through a DefendX Software Control-QFS Admin Client 

Running on a Different Machine 

This section provides step-by-step instructions on installing the DefendX Software Control-QFS 
Admin Client, enabling you to administrate a Control-QFS service running on a different machine. 
This kind of DefendX Software Control-QFS Admin Client installation enables DefendX Software 
Control-QFS administrators easily to administer DefendX Software Control-QFS that is installed 
on all the servers over the entire network. This can be done through a local user interface that is 
Ŝŀǎƛƭȅ ƛƴǎǘŀƭƭŜŘ ƻƴ ǘƘŜ ŀŘƳƛƴƛǎǘǊŀǘƻǊΩǎ ƭƻŎŀƭ ƳŀŎƘƛƴŜΦ 

For an DefendX Software Control-QFS administrator to be able to use the DefendX Software 
Control-QFS Admin Client, DefendX Software Smart Policy Manager Admin and DefendX Software 
Control-QFS !ŘƳƛƴ ŎƻƳǇƻƴŜƴǘǎ ǎƘƻǳƭŘ ōŜ ƛƴǎǘŀƭƭŜŘ ƻƴ ǘƘŜ ŀŘƳƛƴƛǎǘǊŀǘƻǊΩǎ ƭƻŎŀƭ ƳŀŎƘƛƴŜ ŀǎ ǇŜǊ 
the following instructions. 

NOTES: 

¶ There is a slight difference in the installation of DefendX Software Smart Policy 
Manager and DefendX Software Control-QFS on an DefendX Software Control-QFS 
{ŜǊǾŜǊ ǾŜǊǎǳǎ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƻƴ ŀƴ ŀŘƳƛƴƛǎǘǊŀǘƻǊΩǎ ƭƻŎŀƭ ƳŀŎƘƛƴŜΦ 

¶ DefendX Software Control-QFS Admin Client User Interface is using Remote RPC to 
communicate to the DefendX Software Smart Policy Manager service. Therefore, 
DefendX Software Control-QFS Administrator needs to have permissions to run and 
execute Remote RPC on the managed machine. A standard user does not have RPC 
Permission by default. Therefore, if the user performing the administration is not 
an administrator in the domain, the user needs to be added to the Distributed COM 
Users group on the machine to be managed. 
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Installing DefendX Software Smart Policy Manager Admin 
Component 
1. Log on to your local computer, using an account with administrator privileges. 

2. On the DefendX Software Product Installation page, click your product installation link under 
the Product Components section. 

3. When prompted to install DefendX Software Smart Policy Manager, click Yes to launch the 
Installation Wizard.  

 

4. On the DefendX Software Smart Policy Manager installation welcome dialog box, click Next. 

 

 






























































































































